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Technology Tools in the Secondary Social Studies & Language Arts Classroom   
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Good Morning & Welcome Back!

Day 3
You are on your own again this morning to complete the daily morning activities: diary writing, email and site of the day.

1.  Open your diary template:

Find the Training Resources folder on the desktop.

Locate the Diary Template and double click on it to open it.

Respond to the diary question in the slide show.

Print 2 copies. Put one in your group folder and one in your notebook.

Save your document as “Day 3 Diary” in your folder.

2.  Check your E-mail:

Open Netscape or Internet Explorer.

Click in the location box and type the following address:  www.eudoramail.com (Press Enter)

Click inside the Login Name box and key in your login name.

Click inside the Password box and key in your password.

Remember that your login name and password are written on the inside cover of your book.

Click on Enter.

Find the message from me, click on the underlined subject link to open it. 

Read and reply to my E-mail if necessary. 

3. View the “site of the day” How could you use this in your classroom?
What’s Your Opinion?

	Teaching Strategies Modeled
	Technology Strategies Modeled
	Instruction:

Essential Questions for Teachers: How can I use PowerPoint as a multimedia-authoring tool? How can I use Inspiration software as an electronic template for organizing and note taking?  


	Whole group


	Web Browser

http://www.teachtsp2.com/cdonline/
Inspiration

Power Point

On-line tutorial for Power Point- http://www.actden.com/pp/ 

Web Browser

http://www.teachtsp2.com/cdonline/
Inspiration

Power Point

On-line tutorial for Power Point- http://www.actden.com/pp/ 

http://www.forsyth.k12.ga.us/sbeck/digital/goingdigital.htm

	Essential Question: How does culture influence opinions?

Learning Standards (State of Michigan):

Assessed: 

Social Studies Standards 

All students will describe and explain the causes, consequences, and geographic context of major global issues and events.

Gather and analyze information using appropriate information technologies to answer the question posed. Construct an answer to the question posed and support their answer with evidence. 

Report the result of their investigation including the procedures followed.


All students will describe, compare, and explain the locations and characteristics of ecosystems, resources, human adaptation, environmental impact, and the interrelationships among them.


All students will engage their peers in constructive conversation about matters of public concern by clarifying issues, considering opposing views, applying democratic values, anticipating consequences, and working toward making decisions.
Materials: Inspiration, Web browser, storyboard, PowerPoint 

Technology Connections: Students will participate in an on-line cultural debate. They will use an Inspiration template to collect information. Groups will use PowerPoint to produce a multimedia slide show about the opinions. Students will use a digital camera to take pictures for their credits slide. 

Procedures:

Whole Group Work

1. Open the lesson with the question, “Is modern technology always a good thing?” Have students comment on this idea and write on the board their responses. 

2. Go to the on-line cultural debate site and show the debate video about technology. Pause the video throughout to consider questions posed and ideas presented. 

3. Open the Inspiration template and gather facts onto the electronic data collection sheet. 

4. Discuss the 4 opinions and take a vote on which opinion they would choose. 

5. Ask students to site reasons for their opinions and record their thoughts on the Inspiration chart.

6. Discuss how this opinion might change if they were talking about their own life or situation. How would it apply to their life?

Individual Work

7. Have students pull a card from the basket that has their debate assignment on it.  It will give them a team and a debate.

8. Guide them to the templates folder on the desktop. 

9. Walk them through opening up the template and show them the hyperlink to the debates.

10. Students will repeat the same process that was modeled with the whole group. They will take note electronically using the template. When they finish they will print out their template and meet with their issues group and discuss the opinions they have. 

11. Students will then pull into their assigned groups and discuss the 5 debates and the opinions.

12. Students will then use the PowerPoint storyboard to create a slide that represents their opinion and how it might apply in their life.

13. Students create a slide for their group’s multimedia presentation using the PowerPoint slide template. 

14. Students will take pictures of their group members using a digital camera. Each person will have an individual picture and a group shot. The individual picture must in some way represent their opinion on the issue they were assigned.

15. When all the individual slides have been created groups will spilt into two teams and create a “title slide” and “credits slide.”

16. When they have completed the slides they will move the files into a shared folder on the network. 

17. Students will then get back with their group and pull the slides into one slide show.

18. Present slide shows.

Assessment: Assess students’ presentations according to the rubrics.  
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Cultural Debate Group Opinions

	Issue & Question
	Opinion & Personal Application

	Appearance

How important is appearance?
	Mentawai


	
	You

	Ecotourism

Should ecotourism be encouraged or discouraged?
	Mentawai


	
	You

	Education
Is formal education the best education?
	Mentawai


	
	You

	Land
Who should manage public lands?
	Mentawai


	
	You

	Medicine

Is modern medicine the answer?
	Mentawai

	
	You


Cultural Debate Slide Storyboard
	Title Slide

Title of Presentation:                                                                                     Date:

Student Name:

Teacher Name:

__1 Graphic

	Slide 1 (The Mentawai)

Debate Issue:

Question Posed:

Your Opinion:

3 Supporting Thoughts:

__1 Graphic

	Slide 2 (You)

Debate Issue:

Question Posed:

Your Opinion:

3 Supporting Thoughts:

__1 Graphic


Cultural Debate Slide Rubric

Name:

	CATEGORY 
	Excellent 
	Good 
	Satisfactory 
	Needs Improvement 

	Mechanics 
	No misspellings or grammatical errors. 
	Three or fewer misspellings and/or mechanical errors. 
	Four misspellings and/or grammatical errors. 
	More than 4 errors in spelling or grammar. 

	Graphics 
	Required graphics are included on each slide.  They are appropriate and relevant to the topic.
	Required graphics are included on each slide, but may not always be appropriate or relevant to the topic.
	Required graphics are included on at least 3 slides, but some are not appropriate or relevant to the topic.
	Required graphics are missing.  Graphics that are included are not relevant to the topic. 

	Requirements 
	All requirements are met and exceeded. 
	All requirements are met. 
	One requirement was not completely met. 
	More than one requirement was not completely met. 

	Content 
	Covers topic in depth with details and examples. Subject knowledge is excellent.
	Includes essential knowledge about the topic. Subject knowledge appears to be good. 
	Includes essential information about the topic but there are 1-2 factual errors. 
	Content is minimal or there are several factual errors. 

	Organization 
	Content is well organized using headings or bulleted lists to group related material. 
	Uses headings or bulleted lists to organize, but the overall organization of topics appears flawed. 
	Content is logically organized for the most part. 
	There was no clear or logical organizational structure, just lots of facts. 


Software Helper

POWERPOINT
Getting Started:

Auto Content Wizard- Gives you a head start on a presentation with a fill-in-the-blank type of form.  Choose from pre-made presentations on a variety of subjects.

Template- Allows you to start your presentation with a pre-made background for each slide.

Blank Presentation- Start your own presentation with a white background.  To set the background color click on Format and Background.  Click on Format and Apply Design to choose a template background.

Creating a Slide:

Choose an Auto Layout-  

· Choose a layout for your slide.  

· If you need to go back and add something else later, you can click on Insert and the item that you wish to add.

Adding Text-  

· Click on the text box to begin typing.  

· Click on the top toolbar or Format and Font to make changes.  

Adding Graphics-  

· Click on the graphics box if you selected an auto layout.  

· If you wish to add a graphic box to an existing slide, click on Insert and picture.  Double click on the picture to select it.  Once on the slide, you can click on it and drag it into position or click on the corners to size it.

Inserting a Chart-  

· Click on Insert and Chart.  Enter your data in the table.  

· To change the orientation of your chart, click on Data and Series in Rows or Series in Columns.  

· To change the type of graph, click on Chart and Chart Type.  

· Chart and Chart Options allows you to label the X and Y-axis.

· Chart and 3-D view changes how the shadowing on the chart appears.

· View and Datasheet allows you to go back and make changes to your data.

Inserting a Table or Spreadsheet-

· Click on the table button on the top tool bar.

· Choose the size of your table.

· Click to type in each cell.

· If you want a more polished look, click on Table and Table Auto Format.  There are many templates to use as a starting point.

· If you wish to enter a formula into a cell in a spreadsheet, click on Table and Formula.  Remember all formulas must begin with an equal sign.

· Table and Merge combines selected cells and puts them together to make one larger cell.

· Table and Split separates the selected cell into parts.

Inserting Shapes-

· Click on Auto Shapes at the bottom tool bar.

· Choose the shape you wish to include.

· Click beside the Paint Bucket to change the fill color and click on the paintbrush to change the line color.

· Click on the A to begin typing in that shape and click on the arrow beside to change the color.

· Click on the 3-D cube picture to change how the shape appears on the screen.

Inserting Word Art-
· Click on the 3-D letter A at the bottom tool bar.  

· Select a style for your text.

· Type in your text and click OK.

· Size your text by clicking on the corners and dragging.

Putting on the Finishing Touches

Adding Animation Effects-

· Open the slide to which you wish to add effects.

· Click on the first element that you wish to appear on your slide.

· Click on the animated star at the top of the tool bar.

· Choose an effect for your element.  Click preview to see how it works.

· Do the same with each element on the slide.

· To preview your slide, click on Slide Show and Animation Preview.

Choosing a transition-

· Click on Slide Show and Slide Transition.

· Choose a transition, speed and when you want it to appear or move to the next slide.

· Click apply to set the transition for that one slide, click apply to all to choose that transition for all of the slides.

Adding Action Buttons-

· Click on Slide Show and Action Buttons.

· Action Buttons allow you to create a link to another slide, the Internet, sound clip or video.

Check your Spelling-

· Click on the Check ABC button on the top tool bar to check spelling on all of your slides.

Presenting Your Show

Speaker Notes-

· Click on View and Speaker Notes to write notes for yourself to review as you give your presentation.  You will need to print these notes out, as you will not be able to see them when you give your presentation.

Rehearsing Timings-

· Click on Slide Show and Rehearse Timings to pull up your screen and see a stopwatch.

Set up the Show-

· Click on Slide Show and Set up Show to enter your preferences for how to show will advance.  

· You can change the color of the pen and how you want it to appear.

Viewing Your Show-

· Click on Slide Show and View Show to view your show.  

· If you wish to exit the show before it is over hit your escape button on the keyboard.

Going by the Numbers

	Teaching Strategies Modeled
	Technology Strategies Modeled
	Instruction:

Essential Questions for Teachers: How can I use Excel templates to help my students better understand data?


	Whole group


	http://www.cyberschoolbus.un.org/infonation/index.asp
Excel 

www.google.com
	Essential Question: How does the data on Indonesia and Michigan compare? What do these numbers tell us about the countries?
Learning Standards (State of Michigan):

Assessed: 

Social Studies Standards 

All students will describe and explain the causes, consequences, and geographic context of major global issues and events.

Gather and analyze information using appropriate information technologies to answer the question posed. Construct an answer to the question posed and support their answer with evidence. 

Report the result of their investigation including the procedures followed.


All students will describe, compare, and explain the locations and characteristics of ecosystems, resources, human adaptation, environmental impact, and the interrelationships among them.


All students will engage their peers in constructive conversation about matters of public concern by clarifying issues, considering opposing views, applying democratic values, anticipating consequences, and working toward making decisions.
Materials: Web browser, Excel template. 

Technology Connections: Students will gather specific data about Michigan and Indonesia from various Web sites. They will compare this data using an Excel spreadsheet template. 

Procedures:

1. Statement: “We live in an information age. There are mountains of data on all sorts of topics. The challenge is to interpret the data and ask what is the data telling us and what we can learn from the data. What we are going to do today is gather some data on Indonesia and on Michigan and make some comparisons. 

2. Students will use their fact-gathering sheet and the Infonation web site to get started. http://www.cyberschoolbus.un.org/infonation/index.asp
Choose Indonesia from the drop-down list and pull up the country profile.

3. Students will record the data for land area, population, population density and gross domestic product per capita. Introduce these terms by writing each of them on the board and talking about their meaning.  

4. Give students a few minutes to gather the data for Indonesia

5. Next model for students the process for conducting a Web search for the data on Michigan. 

6. Go to Google www.google.com 

7. We are looking for Michigan exports so in the search box you might put “Michigan, exports” or “Michigan exports” and see if that pulls the results you are looking for. Now try the same for Indonesia. “Indonesia, exports” then Indonesia exports,” remember to use the advance search functions available in Google. Now collect the following data via a Web search.

  Total Land, Population, Population Density, GDP per capita

8. Record data on the data collection sheet. 

9. Open up the electronic Excel template and input the data into the fields. 

10. Now that you have the data entered answer the questions on the bottom of the spreadsheet.  

What is the difference in land area?

What is the difference in population? Is Indonesia more or less crowded than Michigan?

You might want to demonstrate the idea of per square kilometer by taping off an area on the floor and putting two people in it. Talk about the physical space they have and the resources- access to water, clean air .... Then add 2 more people and discuss with the students the difference.

What do you think of the difference in GDP per capita? The term is the amount of money people earn annually. How much does that work out to each month? Do things cost the same in Indonesia as they do in Michigan? Do people in Indonesia need the same things?

11. Talk with the students about the comparison that was done. We compared a country with a state. Have them go and grab the same information of Infonation from the United States and plug that into the graph template. Return to the same questions and discuss how the answers changed.

12. Conclude the lesson by asking what other types of data people would want to compare to gain an understanding of a country or a culture. If time allows, gather the data to create other charts.

Assessment: Assess students information gathering skills by checking the accuracy of their data. Review their replies to the 3 questions.


Comparing the Numbers Fact Gathering Sheet

http://www.cyberschoolbus.un.org/infonation/index.asp
	Data
	Indonesia
	Michigan
	United States

	Land Area
	
	
	

	Population
	
	
	

	Population Density
	
	
	

	Gross Domestic Product per Capita
	
	
	


The Internet as a Tool for Educators

The Internet has become a major medium of communication and information. For teachers the Internet is a particularly valuable tool. There is a lot available for teachers that they can grab, adapt, and use which will make their work easier and richer. The Internet exemplifies the expression that many hands make light work. The key to using the Internet productively is to become a savvy, selective surfer of the Web and eventually to contribute back to the education community by contributing your ideas and lessons.

How do I Locate Great Stuff Fast?

Use a Search Utility!
Directories- Libraries on the Web!
The Browse-Search
Directories are designed to be browsed. The web links included in a directory are selected and organized by people. When you search a directory, you search only the material that the directory knows about. Directories often provide some level of review for the material included.

Yahoo

www.yahoo.com
“The Yahoo! directory is an online guide to the World Wide Web. It is created by a staff of editors who visit and evaluate web sites and then organize them into subject-based categories and sub-categories.”

http://help.yahoo.com/help/us/dir/dir-01.html 

About.Com

www.about.com
“Each site in our unique network is run by a professional Guide who is carefully screened and trained by About. Guides build a comprehensive environment around each of their specific topics, including the best new content, relevant links, How-To's, Forums, and answers to just about any question.” 

http://ourstory.about.com/index.htm?PM=59_1100_T
Search Engines

Ask for What You Need!

Spiders/Robots who do the looking for you. These are programs that try to match the keyword or information a user supplies to a web site. Each does it a little differently. Some search the text of web sites. Some search only the titles and some search the text that users do not see.  Search engines do not determine whether it is a good match or not. 

Google

www.google.com
“Currently the largest search engine, indexing billions of web pages. It is a full-text index that searches the entire HTML file.”

Altavista

www.altavista.com
“First, AltaVista checks the words you enter against a massive (half-million entry) phrase dictionary to determine which words go together naturally, and automatically treats them as phrases. In other words, if you enter George Bush or New York or baseball bat, the system knows that those are not just random words, and hence looks first for instances where those complete phrases appear on Web pages, and puts those pages near the top of your list. For instance, DEC tulip (a computer card) is now automatically recognized as a phrase; whereas before that query would have generated lots of results related to flowers, now such a search gives you much more useful results.”

http://www.altavista.com/sites/help/search/search_help
Teoma

http://www.teoma.com/ 

This new search tool uses something the others don’t to return great links to you. Instead of link popularity ranking they use something they call “Subject Specific Popularity.” They determine who the experts in the field are that understand what you are looking for and then derive the link ranking by reviewing what the have linked to. Sound confusing? I’m confused and I just spent 20 minutes trying to figure out how to explain it. I guess it boils down to trying to determine a trusted source and give it more weight in the ranking. What ever they do, it works. 

Meta Search Engines- Engines that search other engines Your Own Personal Shopper
Meta search engines are programmed to search other search engines and return results from those engines. Some allow users to choose the engines that are used in the search. Others offer the capability to search for different types of material, date ranges, or other languages for the search.

Profusion

www.profusion.com
Profusion has recently undergone some changes and come out with a new look and functionality. It still searches other search engines. By clicking on the advanced feature, it allows users to choose what engines or directories to use in the search. One unique feature is the ability to search for pdf. Profusion is now offering a directory that users can click through.

Dogpile

www.dogpile.com
“Dogpile searches four search engines at a time. Lists of results from four engines are displayed on each page. If you do not get at least 10 documents matching your query, Dogpile will automatically search the next four engines, and so, on until all are searched or 10 matches are found.” Dogpile provides a directory and allows users to search for images, audio, ftp files, and a variety of specialized searches by choosing from a drop down menu in their regular search. Users can look for the Custom Search link on the bottom of the home page to choose the search engines Dogpile should use to do the search.

Mamma

www.mamma.com
“Mamma.com is a "Smart Meta Search Engine." When the user enters a query at the Mamma.com website, Mamma's powerful proprietary technology simultaneously queries a series of Search Engines and properly formats the words and syntax for each source being probed. Mamma then creates a virtual database, organizes the results into a uniform format, and presents them by relevance and source. In this manner, Mamma.com provides the end user with a highly relevant and comprehensive set of search results.”

Specialized Searches

Not all engines search for all types of materials. There is a term called the invisible web that describes resources that are on the World Wide Web, but not picked up by search engines.  Material that is stored in databases frequently is not searched. Portable document files (pdf) are not always picked up in searches. Audio and image files are not necessarily picked up. Below is a list of specialized search engines that focus on material on the invisible web.

Altavista Images

http://www.altavista.com/sites/search/simage
Altavista Video

http://www.altavista.com/sites/search/svideo
Altavista MP3/Audio

http://www.altavista.com/sites/search/saudio
Google Images

http://www.google.com/imghp?hl=en
Google File Search

http://www.google.com/advanced_search
Federal Government Search

http://www.ed.gov/
Don’t miss the Advanced Search for format selection.

What strategies should use when I search?

Use More than One

No one search engine or directory is going to meet all your needs. Think about what you are looking for and then try that term in several different search engines or directories. There will be overlap in our results, but you should locate material more quickly.

Learn How the Search Tool Works

When you are learning a new engine, look for a section labeled tips or information. Take a moment to read how that engine or directory works and what special features it may offer. Some engines cache pages so that even if the web page you are looking for is no longer available, you can still see it. Some allow users to be notified is a page changes.

Broaden or Narrow Your Search 

· Think synonyms. Most engines will not pull “amphibians “ or “tadpole” when it is searching for frogs.

· Engines often are very specific. Some distinguish between upper and lower case letters. So “frog” and “Frog” will produce different results. So if you are looking for an exact title use capital letters. If you are not looking for a proper noun, do not use capital letters.

Use Advance Search Features

Look for advanced search functionality in a search engine. Often users will find the option to choose the date of the material, the language, the type of material, the source of the material, and so forth. In addition, advanced searches often provide help with search syntax, which makes combining terms easier.

Evaluating Web Sites
The quality of the sites you select is the most important factor in determining whether or not lessons that you do with the Internet are successful.  As a teacher, you should always look at any sites before your children use them and be sure to explore all links that they may take, to be sure that they are appropriate for your students.  Use the following criteria when deciding which sites to use in your classroom.

Accessibility- Make sure that the site is working on the day of the lesson.  

Don’t just assume that it will be there whenever you need it.  Sites are frequently changed and removed from the web, so just because it was there yesterday doesn’t necessarily mean that it’ll be there today.  Make sure that all the links on that page are working.  Don’t assume anything!

Speed- How long does it take for the students to get to the site?  How long does it take for the site to load?  If a site has wonderful graphics and loads of information on a particular topic but takes 10 minutes to load, you will loose your students’ interest in the process.  If your connection is slow, think about getting WebWacker software that will download sites to a disk so students will have no wait time.

Accuracy- Just because it’s posted on the World Wide Web doesn’t mean 

that the information is accurate.  Anyone can post a web site and many aren’t reliable.  Make sure that the information is presented by a reliable source, that you can locate the same information somewhere else or that you can contact the source to ask questions you may have about the information presented.

Appropriateness-  Keep in mind your students interests, reading level and attention span when choosing a web site.  You may find a super site with good information, but the text may be too difficult for your students.

Appearance- A text-only site may contain a wealth of information, but if there are no graphics that appeal to your students, they will be board and uninterested in it.  Keep in mind the speed issue when judging a site on appearance.  A computer with a slow Internet connection can take much longer to load a site that is full of graphics.

Internet Issues and Pointers

Plug Ins

Plug ins are extra pieces of programming which allows your browser to play audio and video files. These do not come with the browser. They will need to be downloaded and installed on each computer. Test all links to make sure that you do not need a plug in with a site prior to using it with the students.

Acceptable Use Policies

Check with your school’s policy about Internet use with students. If there is an Acceptable Use Policy in place, make sure you have a signed copy for each parent on file prior to using the Internet.

Enlarging Your Screen Size

On a PC to enlarge your web page size click on F11. This hides all the toolbars and fills the screen with the web page image. To turn it off click F11 again.

Enlarging Text Size

If the text is too small for the children, you can increase the size. For the Internet Explorer browser, go to the View menu pull down to text size. Click on a larger size font and give the browser a minute to adjust.

In Netscape, go to the View menu and click on Increase Font.

Internet Safety

Students need to treat the Internet like a stranger and know what information is okay to share and what is not. Young children are not going to be wandering around on the Internet undirected or unaccompanied, but they should know anyway not to give out personal information. 

Things Students Should Know

There are some things that student should know when they go on the web.

Back Key or Arrow-to return to the previous page.

Home Key-to get out of trouble and back to the home page quickly

Google Advanced Search
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Getting Started

	To Open the Advanced Search Window
	· Click on Advanced Search on www.google.com.

· The top four fields in the blue box replace Boolean searches. So instead of having to construct searches using the + or – symbols, Google’s Advanced Search fields performs those functions.


	To Broaden a Search
	· In the search field next to “with all of the words” type the word(s) you wish to search for and then press Google Search.

· Google will return pages with all the terms you list in the search results.

· Another option would be to put the main term in the top field and then list possible additional terms in the field next to “with at least one of the words”.

· In this case Google will look for the top term and include as many of the other terms as possible in the search results.


	To Narrow a Search
	· In the search field next to “with all of the words” type the word(s) you wish to search for and then press Google Search.

· In the field next to “without the words” type the words that should be excluded from the search, then press Google Search.


	To Search for a Phrase
	· In the field next to “with the exact phrase” type the phrase you wish to look for and then press Google Search.

· Google will conduct a complete text search looking for the words in the phrase.


Interpreting Search Results

	Indented Results
	· If more that one page from a site fits the search criteria, the most relevant page is listed first with the other pages indented and listed below it.


	Viewing Missing Web Pages
	· Google’s search results include the title of the web page, the description of the web page and the URL to link to it.

· Google also keeps a copy of the web page for itself. If the page is no longer available, click on cached next to the URL to open and use Google’s copy of the site.


	 Finding Similar Pages
	· If one of the results is exactly what you want, click on Similar Pages, next to cached, to pull up other pages like the one you selected.


Additional Advanced Search Options

	Choosing a Language
	· The Advanced Search will return pages in any language. 

· To restrict results to one language, click on the down arrow next to that field and select the language.


	Selecting File Format Options
	· A powerful option in the advanced search is to restrict the search to a specific file format or to exclude that format from a search.

· With the first down arrow next to the File Format field select Only or Don’t.

· Then click the down arrow next to the second field to search for a specific file format.


	To Limit the Date 
	· If you are searching for material and would like to limit the results to only the most current or updated pages, use the Date field. 

· The down arrow, next to the date field, allows users to limit the search to a time frame for when the page was last updated.


	To Restrict a Search
	· The occurrences field allows users to tell Google where to look for the terms listed in the search boxes


	Using the Domain Feature
	· Using the domain features allows users to restrict a search to specific web site or type of site. For example, limiting a search to URL’s that end in edu will return results that are identify themselves as being a school.


	Filtering
	· Google provides the option to use a filter on searches to eliminate unwanted to material from the results.
· Be aware that the filter is effective but not perfect!


How to Save Graphics from the Internet

1.
Find a graphic on the Internet that you would like to save.

2.
Right click on the image you would like to save and select Save Image As.  On the Mac just click and hold on the graphic and choose “copy to disk”

3.
Change to the appropriate drive.  A file name should appear.  Click Save.       

The graphic was either saved with a .GIF or .JPG extension.  In order to pull the graphic into some Windows programs (ClarisWorks 4.0, Student Writing Center, Kid Pix Studio), the file needs a .BMP extension.  You must open the file in a paint program which allows you to convert the graphic to a .BMP format.  Paint Shop Pro is one example of such a program.  Conversion is unnecessary if your program will accept graphics with a .GIF or .JPG extension.  ClarisWorks 5.0, Kid Pix Studio Deluxe, and HyperStudio will allow you to use graphics with a .GIF and .JPG extension.  The change is not necessary if you are inserting the graphic into Microsoft Word.

4.
Minimize Netscape.

5.
Open Paint Shop Pro.

6.
From the File menu, select Open.

7.
Select the appropriate drive and click on the graphic you just saved. Click 
OK.

8.
The graphic should appear on your screen.

9.
Under the FILE menu, drag down to SAVE AS.

10.
Change the List Files of Type box to .BMP - Windows Bitmap.

11.
Click OK.

12.
Look on the Title Bar. The graphic should now have a file name that ends in .BMP.

13.
File, Exit.

You should be able to pull your graphic into other programs.  This is a great way to create a graphics folder for a theme or unit of study.

* You should get permission to use any graphics that you save or copy from the Internet in order to comply with copyright laws.

How to Copy/Paste Graphics from the Internet

You must use Microsoft Internet Explorer in order to copy/paste graphics from the Internet. Netscape will only let you SAVE the graphics--not copy and paste them.

1.
Open Microsoft Internet Explorer. 
2.
Locate the graphic you wish to copy.

3.
Right click on the graphic (on a Mac just click and hold).  A menu will appear.

4.
Choose Copy.

5.
A copy of the image is placed on the clipboard.

6.
Open the document in which you wish to paste the image.

7.
From the Edit Menu, choose Paste.

Occasionally, using Internet Explorer to copy graphics from a PC results in a distorted image.  The colors don’t always paste into a document as they appeared on the Internet.  In such cases, you should save the image from the Internet rather than copying and pasting.  You may then have to convert the graphic using Paint Shop Pro or some other draw program to a .bmp format in order to use it in your program.

Copying and pasting is an easy way to get a quick graphic from the Internet.  If you’d like to create a graphics folder, you’ll need to save the graphics from the Internet rather than copying and pasting.

* You should get permission to use any graphics that you save or copy from the Internet in order to comply with copyright laws.
How to Copy/Paste Text from the Internet

1.
Open Netscape or Internet Explorer.

2.
Locate the text you wish to copy.

3.
Highlight the text.

4.
From the Edit Menu, choose Copy.

5.
A copy of the text is placed on the clipboard.

6.
Open the document into which you wish to paste the text.

7.
Click to plant the cursor where you would like to paste the text.

8.
From the Edit Menu, choose Paste.

Copying and pasting is an easy way to get text from the Internet. However, you should be mindful of copyright laws and give credit to the Web page from which you took the text.
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How to Cite Resources from the Internet
1. World Wide Web
Structure:

Author. Title of item. [Online] Available http://address/filename, date of document or download.

Example:

Schwartz, Robert. The Cold War Revisited: A Splintered USSR. [Online] Available http://usa.coldwar.server.gov/index/cold.war/countries/former.soviet.block/, November 1, 1998.

2. Email/LISTSERVs

Structure:

Author of email message. Subject line of the message. [Online] Available email: Student@address.edu from Author@address.edu, date of document or download.

Example:

Rule, Christopher. Nile River Research Project results. [Online] Available email: student5@smallvillehigh.edu from ert@informns.k12.mn.us, October 2, 1998.

3. Images/Graphics

Structure:

Description or title of image. [Online] Available http://address/filename, date of document or download.

Example:
Butterfly. [Online Image] Available http://www.kidsdomain.com/holiday/spring/clip.html/ butterfly.gif, October 23, 1998.

4. Sounds
Structure:
Description or title of sound. [Online Sound] Available http://address/file, date of document download.

Example:

Reflections on Apollo. [Online Sound] Available ftp://town.hall.org/radio/

IMS/NASA/100394_nasa_01_ITR.au, September 25, 1998.

5. Video Clips

Structure:
Description or title of video clip. [Online Video Clip] Available http://address/file, date of download.

Example:
Shoemaker-Levy Comet enters Jupiter’s atmosphere and breaks up. [Online Video Clip] Available ftp://ftp.cribx1.u-bordeaux.fr/astro/anim/s19/breakingup.mpg, September 5, 1998.

Easy Bib -  http://www.easybib.com/ 

Noodle Tools - http://www.noodletools.com/ 

Research Organizers

	Research Question 

	1.



	What I already know about my question;



	Important words in my question are;

	
	
	
	

	Synonyms; 

	
	
	
	

	Search Phrases from my question;

	1.

	2.

	3.

	4

	What I have found out.

Harvested Facts!

	1.


	
	2.



	
	3.



	
	4.



	
	5.



	New Questions
	1.



	
	2.



	
	3.



	
	4.




Web Harvest Sheet


Use this sheet to record URLs that you want to remember for later use.

	URL
	Title
	Description

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	


" You can have anything you want �If you will give up the belief that you can't have it."
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